
AUDIO FINISHING from FCPX​ WITH TIM DOLBEAR 

PREPPING THE FILES 
1.​ Create event called FINISHING 

a.​ Purchase any temp music or be sure to license it 
b.​ Duplicate project and put into Finishing event 
c.​ Name it LOCKED 
d.​ Replace the temp music with the licensed music 
e.​ Duplicated again and name it LOCKED for audio​

 
2.​ Open LOCKED for Audio project 

a.​ Create a 2-pop 
i.​ Start by going to the beginning and putting a 2 second gap in the front 

- before the edit starts.  
ii.​ Add a white custom generator at the new beginning (00:00:00:00) and 

set the duration to 1 frame 
iii.​ Go into the FCPX Backup Folder and look for the 2-POP folder and find 

the 2-pop snb adobe audition.wav - drop it it at the beginning and 
change the duration to 1 frame 

iv.​ Copy and paste this into the LOCKED project too so that you can sync 
it all up in the end, just as Tim Dolbear will 

b.​ Assign roles to each audio clip (you may have to add the SCENE and SFX as 
new roles) 

c.​ Dialogue (go to the synced file or the multicam, open it, then select the audio 
and assign it the dialogue role - you don’t have to disconnect the audio track - 
do it from the original file) 

d.​ Scene (do this by selecting the scene clips and assigning a role - even if there 
is video involved) 

e.​ Ambient 
f.​ Music 
g.​ SFX​

 
3.​ Before you remove all effects/volume/pan/etc. on the audio, insert a TIMECODE 

GENERATOR and adjust to the length of the entire project. EXPORT a low res version 
of the video (I used Apple devices SD) for reference and include it in the same folder 
in FOR AUDIO SWEETENING.  
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4.​ By role, select all of the audio and go into effects and clear any effects and panning  

​
 

5.​ Be sure that all audio lanes are turned on. ​

​
 

6.​ Then go to the top menu and select FILE, EXPORT XML.  
a.​ Be sure the source name is the name of the project you’re wanting to export. 
b.​ That the metadata view is GENERAL  
c.​ You’re using the most current XML version.  
d.​ Create a FOLDER called AAF in your exports for audio finishing and save your 

xml there. The file extension will not be xml, it will be .fcpxmld
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7.​ Create an AAF file which is not native to FCPX so not a setting in the share menu. So 
instead, you’ll convert the xml (.fcpxmld) to AAF via X2Pro5. X2Pro5. The interface 
is pretty non-nonsense so below is what you’ll see.  

a.​ In the Project tab, first add the xml you just created in the box on the left then 
drag over the destination folder to the box on the right.  

b.​ In the Roles tab, be sure you have everything turned on that you want.  
c.​ The Media Locations tab is where you point it to the drive or folder that 

contains your media so it can collect and embed in the AAF. 
d.​ Finally, the Options tab should be completed exactly as below unless you get 

instructions otherwise.   ​
​

​
 

8.​ Go back to the PROJECT tab in the X2Pro5 window and hit the white play button on 
the bottom right to begin file conversion. You may have a popup that says something 
about 32 bit floating - don’t worry about it. Just click okay. When it’s done, it may also 
have a popup about not being able to process certain effects [panning] in case you 
forgot to turn that off. Just click okay and keep going with the process.
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​
 

9.​ When it’s done converting, it just brings you back to the project tab with no 
confirmation that anything has been done, but if you look in your AAF folder, you’ll 
see this list of files it created. Just select the one with the .aaf and send the link to 
Tim.​

 ​
 

10.​Zip up all of the files and upload at https://timdolbear.com/upload.htm ​
 

11.​ Email Tim at tim.dolbear@gmail.com to let him know you’ve uploaded. 
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PLACING THE AUDIO​
 
When you get the final master audio use only the STEREO mix labeled [filename]-24LUFS 
(he’ll give you stems if you need them) place it into the LOCKED (not LOCKED for audio) 
project and assign it the role of FINAL MIX (you may have to create it). Then test it by turning 
off the other audio lanes, leaving only FINAL MIX turned on. 
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TIPS FROM GEMINI on X2Pro5, FCPX, and working with the DAW - 
Sequoia 
​
Final Cut Pro: XML Export Settings 

When you select File > Export XML, use these settings in the dialogue box: 

●​ Metadata View: Choose General. 
○​ Why? The "Audio" view is designed for specific archival metadata. For X2Pro5 

to reconstruct the timeline (clips, roles, and levels), the General view provides 
the most reliable "map" of the sequence. 

●​ XML Version: Choose the latest version supported by your X2Pro5 version (usually 
1.12 or 1.13 for X2Pro5). 

○​ Note: If you are using an older version (X2Pro Audio Convert LE), you might 
need to drop down to 1.11, but for X2Pro5, the most current version is 
preferred as it handles "Roles" more effectively. 

2. X2Pro5: Essential Conversion Settings 

Before you hit "Start" in X2Pro5, check these settings to ensure Sequoia can read the file: 

●​ Embed Media: Always select Embed Media (not "Reference"). Sequoia’s ability to 
"relink" to a Mac-formatted file path from a Windows environment is notoriously 
difficult. Embedding the audio directly into the AAF makes the file "portable." 

●​ Trim Media (Handles): Set this to at least 5–10 seconds. This gives the Sequoia mixer 
room to adjust fades. 

●​ Sample Rate: Check Force embedded audio to 48kHz. 
●​ Bit Depth: Choose 24-bit. 

3. Sequoia: AAF Import & Timecode Settings 

When you bring the AAF into Sequoia, the most common issue is "Timecode Drift" or clips 
landing at the wrong spot. 

●​ The "Session Start" Sync: * In Sequoia, ensure your Project Start Time matches your 
FCP timeline (usually 00:00:00:00 or 01:00:00:00). 

○​ When importing, Sequoia will ask if you want to "Keep Source Timecode" or 
"Place at Original Position." Always choose to place clips based on their 
Timeline Position/Timestamp. 

●​ Frame Rate Consistency: * Sequoia is very sensitive to frame rate. If your FCP timeline 
is 23.976 fps, your Sequoia project must be set to 23.976 before you hit import. If 
there is a mismatch, Sequoia may "re-interpret" the audio length, causing it to slowly 
drift out of sync with your video reference. 

●​ The "BWF" Metadata: 
○​ Sequoia excels at reading Broadcast Wave (BWF) data. Since X2Pro5 wraps 

the audio in an AAF container, if a clip seems lost, you can often use Sequoia’s 
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"Object Manager" to see the original timestamp metadata and "snap" the 
object back to its original timecode. 

Summary Checklist 

Step Setting 

FCP XML Export Metadata: General / Version: Current (1.12/1.13) 

X2Pro5 Option Embed Media (mandatory for Sequoia stability) 

X2Pro5 Audio 48kHz / 24-bit 

Sequoia Project Set Frame Rate before importing AAF 

​
Pro Tip for Sequoia: Always export a "Reference Video" (H.264 or ProRes Proxy) from FCP 
with a Timecode Burn-In. Import this video into Sequoia first. If the audio clips from X2Pro5 
don't line up with the numbers burned into the video, you'll know immediately that there is a 
frame-rate interpretation error. 
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CREATING A 2-POP 
 
Creating a "2-pop" in Final Cut Pro (FCP) is a standard practice in video post-production, 
especially for broadcast or theatrical delivery. It's a single frame of a visual cue (usually a 
white flash or a specific graphic) combined with a 1kHz audio tone, placed exactly two 
seconds before the program's first frame of action (FFOA). This serves as a synchronization 
point for various elements during playback and distribution. 
 
1. Understand the Purpose of a 2-Pop 
Synchronization: It helps ensure that video and audio elements are perfectly in sync across 
different playback systems, especially when dealing with separate audio and video masters. 
 
Quality Control: It provides a clear reference point for engineers and quality control 
personnel to verify sync. 
 
Delivery Specification: Many broadcasters and distributors require a 2-pop as part of their 
delivery specifications. 
 
2. Prepare Your Timeline 
Before you start, make sure your timeline is organized and you know where your First Frame 
of Action (FFOA) is. The 2-pop will be placed exactly 2 seconds before this point. 
 
3. Create the Visual Element (The "Pop") 
You have a few options for the visual element: 
 
Option A: Simple White Flash (Recommended) 
 
Go to Generators in the Browser (or Titles and Generators sidebar in newer FCP versions). 
 
Drag the Custom generator (usually found under Solids or Elements) onto your timeline. 
 
In the Inspector, change its color to white. 
 
Set its duration to one frame. You can do this by selecting the clip, typing 1 then . (period) in 
the Duration field in the Inspector or by manually dragging the edges in the timeline. 
 
Option B: Numbered Countdown (More Complex) 
If you need a full countdown (e.g., 10-second countdown with a 2-pop at the end), you can 
use the Countdown generator found in the Titles and Generators sidebar. You'll then need to 
adjust it so that the "2" frame aligns with your 2-second mark. 
 
4. Create the Audio Element (The "Tone") 

8 



AUDIO FINISHING from FCPX​ WITH TIM DOLBEAR 

Final Cut Pro doesn't have a built-in 1kHz tone generator, so you'll need to create one or 
import one. 
 
Option A: Generate in Another Application (Recommended) 
 
Use an audio editing application like Apple's Logic Pro, Audacity (free), or Adobe Audition. 
 
Generate a 1kHz sine wave tone. 
 
Set its duration to one frame (e.g., 1/24th, 1/25th, or 1/30th of a second, depending on your 
project's frame rate). 
 
Export this single-frame tone as a WAV or AIFF file. 
 
Import this audio file into your Final Cut Pro project. 
 
Option B: Find a Pre-made 2-Pop Tone 
 
You might find royalty-free 2-pop audio files online. Ensure they are exactly one frame long 
and at 1kHz. 
 
5. Place the 2-Pop on the Timeline (Revised Method) 
This is the crucial step for accurate placement, especially when your project starts at 
00:00:00:00. Since you cannot have a negative timecode, you must first create space. 
 
Identify your FFOA: Go to the very first frame of your program's actual content. This is your 
FFOA. 
 
Add a Gap Clip: Place your playhead directly on the FFOA. Press Option + W to insert a Gap 
Clip. This will push your entire project to the right, creating a new space. 
 
Set the Gap Clip duration: The Gap Clip will be longer than you need. Select the Gap Clip, 
then press Control + D to enter the duration. Type 2. (for 2 seconds) and press Enter. The Gap 
Clip will now be exactly 2 seconds long. Your FFOA should now be at 00:00:02:00. 
 
Position the playhead: With your FFOA at 00:00:02:00, you can now safely move the 
playhead back two seconds to 00:00:00:00. The easiest way is to click on the timecode 
display below the viewer, type 0, and press Enter. 
 
Place the visual pop: Drag your one-frame white solid (or countdown "2" frame) to this exact 
playhead position (00:00:00:00). 
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Place the audio tone: Drag your one-frame 1kHz audio tone to the same exact playhead 
position, aligning it precisely with the visual pop. Ensure the audio tone is on a separate 
audio track or clearly distinguishable. 
 
6. Verify the 2-Pop 
Zoom in: Zoom in very closely on your timeline to ensure the visual and audio elements of 
the 2-pop are perfectly aligned and exactly one frame long. 
 
Play and Listen: Play back the section leading up to your FFOA. You should see the single 
white flash and hear the single "pop" sound exactly two seconds before your program 
begins. 
 
Check Timecode: Verify that the 2-pop occurs at the correct timecode relative to your FFOA 
(e.g., if your FFOA is at 00:00:02:00, the 2-pop should be at 00:00:00:00). 
 
Tips for Best Practice: 
Black Leader: It's common practice to have 8-10 seconds of black leader before the 2-pop, 
and then 2 seconds of black leader between the 2-pop and the FFOA. 
 
Mute Other Audio: Ensure no other audio is playing during the 2-pop. 
 
Standard Levels: Set the 1kHz tone to a standard broadcast level, typically around -20 dBFS 
(decibels Full Scale) or -18 dBFS, depending on your region's loudness standards. 
 
Save as a Compound Clip/Template: Once you've created a perfect 2-pop, consider saving 
it as a compound clip or even a template in your FCP library so you can easily reuse it for 
future projects. 
 
By following these steps, you can accurately and effectively create a 2-pop in Final Cut Pro, 
ensuring your projects meet professional delivery standards. 
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